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LONG FILE NAMES

LONG FILE NAMES

COMPATIBILITY WITH PREVIOUS VERSIONS OF BuildersCAD

BuildersCAD

Longer file names are allowed in . Longer file names allow for more
flexibility in naming, particularly for repeated items and layers. In addition, fewer name
restrictions provide for better compatibility with other software in translations.

BuildersCAD 9.1

The warning can be disabled for the

current session by
checking the box in the dialog. The
warning can be disabled permanently
by setting the “skip version check on
save” preference in the Preferences
menu.

BuildersCAD

Drawings in format may be saved in

format using the
option in the Save command. When saving as

will check the
drawing and give an error message if anything preventing
the SaveAs 8.3 is found.

The drawing cannot contain long file names.

RI Libraries modified in cannot be

used in previous versions of

BuildersCAD 9.1

BuildersCAD 8.3 BuildersCAD 8.3

BuildersCAD 8.3, BuildersCAD

BuildersCAD 9.1

BuildersCAD.

�

�

Drawings saved in cannot be loaded into previous versions of

When saving a drawing which was created in 8.3 or earlier, you will be
warned on your first Save attempt, that this file will no longer open in version 8.3 or
earlier.

BuildersCAD 9.1

BuildersCAD.

�

�

�

There is a maximum length of 64 characters for layer names, database names,

drawings/sheet names, and repeated item names. Other files types

have a maximum length of 128 characters. Refer to the Files topic in
Encyclopedia for a complete list of file extensions

Spaces are allowed in file names but are not recommended. Support of spaces in file
names is dependant on your operating system. If you are using a Unix server on a
network, spaces should not be used in file names.

Dots are not allowed in file names except for the one separating the file name from the
file extension.

BuildersCAD

BuildersCAD

SAVING DRAWINGS IN VERSION 8.3BuildersCAD 9.1

SAVING IN BuildersCAD 9.1

OPTIONS

def: yes
quick

BuildersCAD83
yes

no

Save database?

Save Drawing
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VIEW
CHANGES TO THE VIEW CONTROL BAR

VIEW MENU

PERSPECTIVE VIEW

The View Control Bar has been changed to incorporate some of the new dynamic

viewing functions. Refer to the View Control Bar topic in the
Encyclopedia for a complete description of View Control Bar functions.

BuildersCAD

The View menu has been
redesigned to include the
new Dynamic View,
Perspective, and OpenGL
functions.

A new perspective view menu allows you to set the parameters for generating a

perspective view in and then displaying the view. The perspective view
is generated by viewing from an Observer Point, looking toward a Look Point, using a
ViewAngle, and a Z Clip Plane.

BuildersCAD

The Observer Point height, Look
Point height, Z Clip Plane and View
Angle parameters must be set
before the view is generated. Refer
t o t h e V i e w t o p i c i n t h e

Encyclopedia. for
more information.
BuildersCAD

BuildersCAD

View Menu

Database

Static View

Workplane

REAR

FRONT

LEFT RIGHT

Off

Orient View To

Dynamic View

Perspective

Current View

OrthoPlan Persp

OpenGL

Solid

Textures

Floating
Menu

Floating
Menu

Zoom

Zoom Factor

0.75

Special Display

Screen Image View Files

All
Winports

Data
Points

Retain

Winport Quad

Assign
Textures

OnEdge
Highlight

Wire
Frame

Hidden
Line

OpenGL Mode

Edge Color

N/AWhite

Background Color

N/A

N/A

Lines

Shadows

Reflection

Off

The new Dynamic View
functions include Orbit,
Spin (around Z axis),
Walk, Swivel, Pan, and
Zoom.

T h e n e w O p e n G L
functions include Solid,
Edge Highlight, Wire
Frame, and Hidden Line.
OpenGL also has options
to render Textures and

L ine
entities.
Bui ldersCAD
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DYNAMIC VIEW

The Dynamic View portion of the View menu contains commands that allow you to

change the view in dynamically. There are 6 dynamic view commands.BuildersCAD

You can also dynamically zoom the drawing using the scroll wheel on a scroll wheel

mouse. The dynamic pan feature can also be used at any time in by
pressing and holding the <Ctrl> key, pressing and holding the left mouse button and
dragging the view to a new location.

BuildersCAD

The Dynamic View functions are also found on a Windows floating toolbar.

The OpenGLfunctions are also found on a Windows floating toolbar.

Orbit

ZAxis Spin

Walk

Swivel

Pan

Zoom

VIEW COMMANDS

OPENGL

Beginning with , supports rendering using the
OpenGL rendering engine found in the operating system. OpenGL is a graphics
language developed by Silicon Graphics. Microsoft OpenGL is built into MS Windows
and designed to improve performance on hardware that supports the OpenGL

standard. OpenGL allows to display rendered images quickly, to pan, to
zoom, place items and perform edits in rendered image mode in real time.

OpenGL also supports textures. Refer to the Textures topic for more
information.

The OpenGL settings are found on the View menu. This menu is accessed by selecting

the camera icon on the View Control Bar. Refer to the Encyclopedia’s
View and View Control Bar topics.

BuildersCAD 9.1 BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD
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TEXTURES

Textures

OpenGL

are graphic representations of materials which are mapped to 3D surfaces.
When a texture is mapped to a 3D surface and the surface is displayed in

with the Textures feature of turned on, the surface will display
with the defined texture.

Textures are assigned to 3D surfaces in using the
menu. This menu is accessed in the 3D module by selecting the button
on the menu. The menu is an MS Windows floating menu. It
will remain on the screen until cleared using the "X" in the top right corner.

BuildersCAD

BuildersCAD Assign Textures

3D Main Assign Textures
Assign Textures

Textures are assigned to surfaces by Color number.
can use up to 256 different colors in a given model - therefore up to 256 different textures

may be assigned in the model. Textures are displayed in when the
OpenGLView mode is set to Textures. Refer to the OpenGLtopic for more information.

BuildersCAD BuildersCAD

BuildersCAD

BuildersCAD
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BuildersCAD PAINT

The Paint feature is designed to provide tools to highlight, colorize, or

mark up your drawing. The Paint Dialog menu is accessed by selecting

the Paint (paint brush) icon on the Main menu. This menu is a Windows

floating menu. It may be moved around the screen and will remain up until closed by

selecting the "X" in the top right corner of the menu. The Paint Dialog

menu may also be called from the Toolbars portion of the default Windows Menu Bar.
Refer to the Windows Menu Bar topic for more information.

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

Paint entities are somewhat different than other

entities. The Paint entity is a raster type of entity, not vector. It therefore does not have

addressable "points" or scale. Paint entities are placed in the current

work layer and display with the layer, similar to other entities.

will display Paint entites last, after all other entities in the layer are

displayed, regardless of the order in which the entities are placed.

Paint entities may not be selected, moved, or edited once they are

placed, except with the Paint Undo and Redo buttons.

Paint entities are not included in the Entity Count for the layer found

on the Layer menu.

Paint entities must be plotted by plotting to a raster image, and then

sending the raster image to the plotter. Refer to the Output To - Raster section of the

Plot topic. This means that plots which incorporate Paint will be of

lower quality than plots made directly - depending on the resolution you select for the
intermediate raster image.

NOTE: While Paint entities may be drawn on any layer with other entity

types, it is highly recommended that you create a specific layer just for Paint entities to

separate them from other entity types.

�

�

�

�

BuildersCAD
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MULTI-LAYER RIs

BuildersCAD 9.1 now supports Multi-Layer Repeated Items. Multi-Layer RIs allow a
single Repeated Item to display geometry which can be turned on and off with one or
more layers. You can place geometry which you only want to see if certain layers are
turned on within a single RI, and toggle the display of the geometry by turning on and off
the proper layers.

A Multi-Layer Repeated Item is the same as any other Repeated Item except that it
contains layer information as flags for the entities contained within it. It is stored in a
library and placed using the Repeated Item Select menu (or RI placement mnemonics),
just like any other Repeated Item. It can be included in a Repeated Item Catalog.AMulti-
Layer RI may be placed on any layer.

� A Multi-Layer Repeated Item is still a single entity which is placed on a single layer. When a
Multi-Layer RI is created, the layer name where each entity included within the RI is drawn is
stored within the RI.

� Entities in Multi-Layer RIs (and other Multi-Layer functions) will operate with a set of flags that
comprise a 64 character layer name. This is the maximum length for a layer name.

� Extrema will not check for layer modes. An Unzoom will zoom to the entire Repeated Item,
even if some layers to display a portion of the RI are turned off.

� Edits are performed in the placement layer only. If you delete the RI, or move the RI, the entire
RI is deleted or moved, including parts which display in layers that are turned off and are thus
not currently visible.

� Searches will check the display layers. If you are searching for the display list of a point such as
the endpoint of a line within the RI, the point or line must be in a layer that is currently visible.

There are two basic types of Multi-Layer Repeated Items - Fixed Layer and

Variable Layer. With Fixed Layer Multi-Layer RIs, the display layer names for

entities within the RI are fixed to specific layer names. The entities will only

display when the specific layer name is present and turned on. Relative Layer

Multi-Layer RIs store a portion of the layer name at the time the RI is created and

append it to a portion of the placement layer name to determine the display layer

name for specific entities within the RI.

Creating a Multi-Layer Repeated Item is similar to

creating a standard RI. You must first draw the item.

In the case of the Multi-Layer RI, the geometry to be

included in the RI may be drawn across multiple

layers. A new Create Multi-Layer menu allows you

to create the actual RI.

Refer to the Repeated Items topic in the

Encyclopedia.BuildersCAD

CREATE A MULTI-LAYER RI

BuildersCAD
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DISPLAY

The normal menu system is
designed for a standard monitor aspect ratio of
4x3. It may now be adjusted for wide screen
monitors (wide aspect ratio) by the "Wide
Screen Menu Adjust" setting in the Preferences
menu. Refer to the Preferences topic for more
information. When this preference is set, as the

window is adjusted to a wider
proportion, the menu system will shift to the wide
screen mode, allowing more space in the
drawing window and maintaining the proper
proportions of the menus themselves.

BuildersCAD

BuildersCAD

WIDE SCREEN MONITORS

SMALL MENUS

WINDOW SIZE & POSITION

The size of the menus relative
to the drawing window may be altered by setting
an Environment Variable. This variable is
"GMENU_SIZE" and represents a percentage
of full size. The default is 100. For example a
setting "GMENU_SIZE=50 would make the

menus 50% of their original
size. This may be useful on high resolution
monitors to give more room to the drawing
window. Refer to the Environment Variables

topic in the Encyclopedia for
more information.

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD 9.1

BuildersCAD

BuildersCAD

BuildersCAD

has a new environment
variable which allows you to specify the location

of the window when

starts. This feature is designed
to support Windows system with multiple
monitors. Refer to the Preferences topic in the

Encyclopedia.

BuildersCAD
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PLOTTING

PLOTTING TO RASTER IMAGE

PLOTTING TO MULTI-PAGE PDF

BuildersCAD 9.1

BuildersCAD

will now plot to supported raster file types such as .jpg, .png, and
.bmp. If the output is to a Raster file, the bitmap resolution (dots per inch) is plotted as
set in the "Plot To Raster Resolution" setting in the Preferences menu. Refer to the Plot

and Preferences topics in the Encyclopedia for more information.

You can now specify that different layers are plotted to different pages in a PDF file with

the Export to PDF menu.BuildersCAD

There are three basic modes.

1. Plot all layers to a single page (default)

2. Plot every layer to a different page.

3. Plot groups of layers to the same page using a layer name filter.
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AUTHORIZATION

Authorization codes for are now entered in the new internal

Authorization Code Manager. This menu is accessed by selecting the
Customization pull down menu and then selecting the Authorize button. It may also be
accessed by selecting Help on the Windows Menu Bar and then Authorize

on the drop down menu.

BuildersCAD 9.1

BuildersCAD

BuildersCAD

TheAuthorization Manager menu displays information about your system, including the

date and the location in your computer file system of your installation.
The primary parts of the menu are a section for identifying your Host ID including
selection of key type, and a section for displaying and entering your authorization codes.

Refer to theAuthorization topic in the Encyclopedia.

BuildersCAD

BuildersCAD

WINDOWS MENU BAR

BuildersCAD 9.1

BuildersCAD

BuildersCAD

BuildersCAD

has a new standard Windows Menu Bar across the top of the

Window. This bar allows selection of many of the functions of

from a standard MS Windows interface. The Windows Menu Bar

duplicates most of the functions found on the Desktop menu.

The Windows Menu Bar may be turned on or off in the
Preferences menu. It may also be customized to rearrange,
delete, or add new selections. Refer to the Windows Menu

Bar and Preferences topics in the

Encyclopedia.

BuildersCAD
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PREFERENCES MENU

ENVIRONMENT DEFAULTS MANAGER

The Preferences menu has been changed to regroup similar settings
and add new preference settings.

BuildersCAD

The Environment Defaults Manager menu is designed to help easily
manage the Environment Variables found in the Environment Defaults File. This file

read by when it starts up to set various aspects of your
environment.

The Environment Defaults Manager menu allows you to set some of the more common
environment variables directly such as the standards directory, temp directory, and
default text editor. It also displays and allows you to edit the environment defaults file
itself for less common variables.

BuildersCAD

BuildersCAD BuildersCAD

Refer to the Environment Defaults Manager topic in the Encyclopedia.BuildersCAD

BuildersCAD
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MISCELLANEOUS

A circle boundary placement option has been added to the
Patterns menu.

CIRCLE CROSS-HATCH PLACEMENT

BuildersCAD

MANUAL DIMENSION ENHANCEMENTS

A user defined prompt choice feature has been added to manual dimensioning.
This allows the user to customize choices offered at the manual dimension
prompt, as well as provides common defaults.

LAYER TOOLS

A new “Select Off” button has been added to the Layer Tools menu which allows
you to turn one or more layers off by selecting an entity on that layer.

NOTES

Notes may now be placed using 2 new types of note - Paragraph Text places the
note as a paragraph text entity (with separate leader) instead of a Note entity, and
Frozen Key places a keynote as a separate RI, Text, and leader lines instead of
the Keynote entity.

A “Leader Only” function has been added to the Notes menu to place a leader
independent of a note.

The Notes Copy function now copies the note using the parameters from the note
being copied instead of the default parameters as set in the Note Parameter
Manager.

ROOFS

The term “Sub-Roof” is now used to describe the different portions of a roof (A, B,
C, etc.) which may be created. This is to avoid confusion in referencing the
portions of the roof versus the roof overall as a whole.

Pull Lists and Materials Reports

Prior to the wall framing project (*.wf) for a database had to
be located in the user home directory to be able to run a Pull List or Materials

Report. As of you can have your database and wall framing
project in a folder other than your user home directory, but you must also have a
copy of your global.icg and pm_puse.dir in the same directory as the database in
order to run a Pull List or Materials Report.

BuildersCAD 9.1

BuildersCAD 9.1

If you store work in a sub-directory inside the user home directory, even if you
have the wall framing project, global.icg, and pm_puse.dir in the directory,

will give an error message indicating that the wall framing project
is not in the proper location. Select and the Pull List will run properly
despite the error message.

BuildersCAD

Proceed
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BUG FIXES
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Radius dimensions now give the correct angle output.

The dimension change text string function now correctly edits text to
uppercase.

The $ATEXT utility recognizes fonts by name as well as table number. The
SYSMENU.LT font is the default.

The room labels now recognize the caps setting for upper
case.

Plot Preview no longer reports the plot as sent to the plotter.

Notes now place at the correct angle with work angle on.

Arcs which are placed to the left or below the database origin now display
properly.

Find circle quadrant now properly takes workplane/angle into consideration.

Label text displays properly when the label is rotated

2D door repeated items are now completely flat with no Z axis rounding
error.

The j-painter utility now properly saves a screen for launch to a paint
program.

now properly cuts holes through a slab, with the back side
surfaces properly cut.

no longer has an error in changing from one roof level to
another.

A bug in where erasing a wall causes extra layers to be
created has been fixed.

Wall Panel length now properly takes Wall Laps into consideration.

Framing of Floors and Roofs no longer erases previous data from the other
(Roof / Floor) application.

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD

BuildersCAD


